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ABSTRAKT 

Práce se zabývá návrhem 3D banneru a 3D modelu pro elektronický obchod pomocí 

nových moderních technologií. 

ABSTRACT 

This document deals with design of 3D banner and model for an electronic shop using 

modern technologies. 
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Úvod 

S elektronickými obchody se setkáváme v současnosti kaţdý den. Ať uţ se jedná 

o reklamní upoutávky ve městech nebo při surfování na našich oblíbených webových 

serverech, kde jsme „bombardováni“ reklamními bannery, flashovými reklamami nebo 

nyní s příchodem 3D televizorů, kde internetové obchodování bude v blízké době 

téţ běţnou záleţitostí jako na běţném počítači. Majitelé většiny dnešních kamenných 

obchodů zakládají i elektronické obchody. Existuje celé spektrum elektronických 

obchodů z různých druhů podnikání, počínaje elektronikou, hračkami, oblečením 

aţ po různé bizarnosti. Výhod elektronických obchodů je mnoho. Například niţší ceny, 

otvírací doba 24 hodin denně, velký výběr zboţí, dodání aţ domů aj. Nákupy lze 

uskutečnit nejen v rámci jedné země, ale i v globálním měřítku. Nelze pominout i jisté 

nevýhody, např. obtíţnější reklamace, v některých odvětvích je důleţité si daný předmět 

osahat nebo vyzkoušet, coţ přes e-shop nelze, neboť nestačí pouhá fotografie objektu. 

Přicházejí nové moţnosti jako 3D modely produktů. Ty však často vyţadují 

nainstalovanou Javu nebo jiný podpůrný program. Méně zkušení uţivatelé si nemusejí 

vědět rady při instalaci těchto programů nebo mohou nastat problémy s kompatibilitou 

s prohlíţeči. 

Proto bych svoji práci chtěl zaměřit právě na tuto oblast. Chci navrhnout interaktivní 

model 3D banneru a 3D model objektu pomocí jazyka flash s vyuţitím moderních 

metod 3D knihoven pro tento jazyk. Díky lepší podpoře technologie flash ze strany 

internetových prohlíţečů (často jiţ součást prohlíţeče) a případné jednoduché instalaci, 

chci odstranit komplikace s kompatibilitou a zvýšit podporu 3D modelů 

v elektronickém obchodě. 
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Systémové vymezení problému  

V bakalářské práci jsem se rozhodl řešit problematiku moderních trendů elektronického 

obchodu se zaměřením na vyuţití třídimenzionálního rozměru v této oblasti. V první 

části práce, která se zabývá součastným stavem, se soustředím na oblast 

2D a 3D grafiky. K analýze řešeného problému vyuţiji SWOT analýzy. Dále se věnuji 

potřebným programům a knihovnám, jejich instalací a nastavením tak, aby bylo vše 

připravené na samotnou práci s programem pro realizaci mých návrhů. K tomu pouţiji 

software FlashDevelop, který slouţí pro psaní kódu flash a knihovny rozšiřující 

moţnosti tohoto jazyka. Podrobné nastavení všech pouţitých aplikací a jejich popis je 

uvedeno v kapitole 4. 
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Cíl práce 

Cílem práce je vyuţít nové moderní trendy elektronického obchodu k návrhu a tvorbě 

katalogů. 

Dílčí cíl 

Aplikace 3D pro elektronický obchod a praktické moţnosti vyuţití návrhu. 
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1. Informační zdroje 

Uţ v dávných dobách měla informace strategicky velký význam. Pomáhala velkým 

vůdcům vyhrávat strategické bitvy. Díky tomu přicházeli o menší ztráty na ţivotech, 

stali se slavnými a píše se o nich v knihách, ze kterých i my můţeme čerpat informace.  

V současnosti si místo vůdce můţeme představit člověka zakládajícího firmu, 

který se snaţí získat strategické místo na trhu. Bez dostatečného mnoţství informací 

stěţí překoná konkurenci k dosaţení svého cíle. Stejně je tomu u psaní prácí, organizace 

firmy, projektovém managementu aj. Proto je nutné vyhledat vhodné informační zdroje, 

dobře se v nich orientovat a správně vyuţít. 

Zdrojů pro čerpání informací je spousta. Rozdělit se dají do několika oblastí: 

 Tištěné zdroje: 

 kniha, 

 část knihy, 

 příspěvek, 

 článek, 

 akademická práce, 

 legislativní dokument, 

 standard. 

 Elektronické zdroje: 

 e-kniha, 

 část e-knihy, 

 e-příspěvek, 

 e-článek, 

 e-akademická práce, 

 web a webové sídlo, 

 webová stránka. 

 Ostatní informační zdroje. 
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Základním zdrojem informací jsou knihy, kde najdeme všechny informace potřebné 

pro naše účely. Pokud situace vyţaduje aktuální informace, internet je v současnosti 

tou nejlepší zbraní. Je třeba si dávat pozor, ne všechny informace z webových stránek 

mají skutečnou hodnotu. Existují volně dostupné informace, jiné lze získat za určitou 

cenu nebo poplatkem při registraci na placených serverech. 

1.1. Klasické informační zdroje 

Knihy patří k základnímu stavebnímu kameni vyhledávání informací. Přináší obecný 

pohled na danou problematiku. Čerpáme z nich teoretické i historické údaje. Nejsou 

příliš aktuální, jelikoţ současný vývoj technologií je velmi rychlý. I přesto ve své práci 

tyto kniţní zdroje vyuţívám a čerpám z nich.  

Klasické informační zdroje jsou součástí přílohy č. 1. 

1.2. Elektronické informační zdroje 

Novinky a aktuální dění ve světě podává internet. Technologie aplikovaná 

k exportování 3D modelu pro internetový prohlíţeč není příliš stará, proto velkou část 

zdrojů v práci tvoří internetové zdroje. Jako centrum pro vyhledávání informací 

vyuţívám internetového vyhledávače Google. 

Vynikajícím českým elektronickým zdrojem, který pouţívám při vyhledávání zdrojů 

je webarchiv.cz. Obsahuje obrovské mnoţství českých webových portálů a dalších 

uţitečných informací. 

Seznam elektronických zdrojů je uveden v příloze č. 2. 

1.3. Virtuální knihovny 

Virtuální knihovny tvoří značné centrum informací o vydaných knihách, publikacích 

a jiných zdrojích z celého světa např. Anglie, USA, Německo, Finsko, ale také 

Japonsko aj.  
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Seznam virtuálních knihoven je v příloze č. 3. 

1.4. Ostatní zdroje informací 

Mezi další zdroje informací v mé práci patři nápovědy grafických aplikací 

jako 3D studioMax a programu FlashDevelop. Taktéţ nápovědy formou tutoriálů 

na webových portálech. Blogy zabývající se programováním v jazyce actionscript 3 

pro aplikaci flash aj. 

Ostatní zdroje informací jsou uvedeny v příloze č. 4. 
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2. Současný stav řešené problematiky 

Bouřlivý rozvoj internetu po celém světě zapříčinil i obrovský boom internetového 

obchodování. Prostřednictvím internetu si v dnešní době můţeme objednat snad 

cokoliv, na co jen pomyslíme. Existuje ale i mnoho faktorů, které omezují prodej 

některých produktů. Mezi takové faktory patří obecně např. velikost (oblečení, bot aj.). 

Někdy také obyčejná fotografie produktu omezuje zákazníka představit si celkový 

vizuální pohled na objekt, např. při koupi nábytku.  

Zde přichází počítačová 3D grafika, která v posledních letech zaţívá velký rozvoj 

v obchodu a multimediích. Dříve se technologie třídimenzionálního pohledu týkala 

hlavně herního průmyslu, kde s rozvojem nových grafických čipů dvou gigantu Nvidia 

a ATI dosahuje úroveň grafických detailů neuvěřitelných detailů. Ruku k dílu přiloţila 

téţ nová technologie DirectX 11, kterou si chválí mnoho herních vývojářů. O novinkách 

technologie DirectX se budu věnovat v kapitole o 3D grafice. Nejprve se ale zaměřím 

na 2D grafiku a pojmy s ní spojené. 

2.1. 2D grafika 

Existují dva základní přístupy ke dvoudimenzionální grafice – vektorová a rastrová 

grafika. 

2.1.1. Rastrová grafika 

V bitmapové grafice je celý obrázek popsán pomocí jednotlivých barevných bodů 

(pixelů). Ty jsou organizovány jako dvourozměrná matice bodů. Kaţdý pixel nese 

specifické informace, například o jasu, barvě, průhlednosti bodu, nebo kombinaci těchto 

hodnot. Obrázek v rastrové grafice má omezené rozlišení, které se udává počtem řádků 

a sloupců.[10] 

 Nevýhody rastrové grafiky: 

 Velké nároky na kapacitu (při vysokém rozlišení a barevné hloubce 

dosahuje velikosti aţ několika jednotek nebo i desítek megabytů), 
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 změna velikosti vede ke zhoršení kvality obrázku. 

 Výhody rastrové grafiky: 

 Snadné pořízení obrázku např. pomocí fotografie nebo scanneru. 

2.1.2. Vektorová grafika 

Vektorová grafika reprezentuje jednoduché zobrazení sestávající ze základních 

geometrických tvarů a křivek jako např. obdélník, elipsa, úsečka, křivka, text, výplň 

a obrys. Neznamená to však, ţe pomocí vektorů nelze vytvořit i velmi komplikované 

nebo realistické kresby. Vektorové objekty nejsou tvořeny jednotlivými body, 

ale křivkami. Je proto moţné je téměř libovolně zvětšovat a zmenšovat bez ztráty 

kvality. Mezi nejrozšířenější programy pro tvorbu vektorové grafiky patří Adobe 

Illustrator a CorelDraw. S křivkami a objekty však můţeme pracovat i v mnoha dalších 

programech, například Adobe Indesignu, určenému k sazbě dokumentů. Práci s vektory 

do jisté míry podporuje i Adobe Photoshop, kde můţeme pouţívat jak vrstvy 

s rastrovými obrázky, tak písmo a zmíněné vektorové objekty.[9]  

 Výhody vektorové grafiky: 

 Libovolné zmenšování nebo zvětšování obrázku bez ztráty kvality, 

 moţnost pracovat s kaţdým objektem obrázku odděleně, 

 nároky na kapacitu jsou obvykle mnohem menší neţ u rastrové grafiky. 

 Nevýhody vektorové grafiky: 

 Sloţitější pořízení obrázku neţ u rastrové grafiky (fotoaparát, scanner). 

2.1.3. Bitová hloubka 

Určuje, jaké mnoţství barevných informací je dostupné pro kaţdý obrazový bod 

v obrazu. Čím více je informačních bitů na obrazový bod, tím více je barev k dispozici 

a tím je i přesnější reprezentace barev. 

Například bitová hloubka 1 bit nese dvě moţné hodnoty – černou a bílou. Obraz 

s bitovou hloubkou 8 bitů má 265 moţných hodnot (2
8
). Pokud bychom měli obraz 

ve stupni šedi s bitovou hloubkou 8 bitů, bude mít 256 moţných hodnot šedé. 
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U barevných obrázků se obvykle setkáme s bitovou hloubkou 8 bitů na barevný kanál 

(viz. Barevný model RGB, CMYK a Lab). Pro barevný kanál RGB je to 24 bitů 

(8+8+8=24). S barevnou hloubkou 24 bitů získáme 2
24

, tedy číslo přesahující 

16 milionů barev. I takto vysoká hodnota nemusí být v některých případech dostačující. 

Některé programy jako např. Adobe Photoshop umoţňují práci s obrazy obsahující 

16 nebo dokonce 32 bitovou hloubku na kanál. Obrazům s 32 bity na kanál jsou známé 

jako obrazy s vysokým dynamickým rozsahem (HDR – High Dynamic Range). S vyšší 

bitovou hloubkou narůstá i datový objem souboru a s tím spojené časové nároky 

na zpracování.[10] 

2.1.4. Velikost versus DPI 

Rozlišení a velikost obrázku jsou často zaměňované pojmy. Pokud máme obrázek 

s rozlišením 300 dpi, víme jen to, ţe pro tisk je rozlišení dostačující, ale chybí zde 

to nejdůleţitější – informace o velikosti obrazu. Jestliţe máme obrázek o rozlišení 

300 dpi při velikosti 20 cm na šířku, pak je informace úplná a víme, ţe fotografii 

můţeme vytisknout bez obav ve velikosti 20 cm. Jednotka dpi (dots per inch) popisuje 

potřebné rozlišení pro výstupní zařízení, které pouţijeme pro zobrazení. Jedná 

se o počet bodů na jeden palec (2,54 cm). Například údaj 300 dpi znamená, ţe tiskové 

zařízení pouţije při zpracování obrázku celkem 300 bodů na délku 2,54 cm. Rozlišení 

monitoru se pohybuje okolo 72 dpi. Z toho vyplývá rozdíl ve velikosti zobrazení. 

Snímek o daném rozlišení např. 1024 x 768 px bude na monitoru zobrazen větší 

neţ na výtisku.[8]  

Vodítkem pro posouzení velikosti obrázku je znalost rozměru obrazu v axelech. 

Například šířka 3600 px znamená, ţe při rozlišení výstupního zařízení 300 dpi lze 

vytisknout v šířce 30,48 cm. Výpočet je snadný: šířku (3600 px) v axelech vydělím 

poţadovaným rozlišením (300 dpi) a tím získám velikost v palcích. Číslo vynásobím 

hodnotou 2,54 a dostanu výsledek v centimetrech. 

 

 



 

 

- 19 - 

 

2.1.5. HDTV 

Zobrazovací mód standardu HDTV, při kterém je obraz rozdělen na 1080 vertikálních 

linek. Rozlišení 1920 x 1080i nebo 1920 x 540p. Písmenko i znamená slovo interlaced, 

neboli „prokládané”. Rozlišení obrazu je 1920 × 1080 pixelů a poměr stran 16:9, 

nicméně počet pixelů je poloviční oproti módu 1080p, tedy 1,04 milionu. Nejčastěji 

se vyuţívá frame-rate, tedy počet snímků za sekundu, 50 Hz a 60 Hz. Kvalita obrazu 

je tak papírově niţší neţ v případě 1080p. Skutečný, viditelný rozdíl mezi 1080i 

a 1080p je pouhým okem jen velmi těţko postřehnutelný. Navíc 1080i podporují 

i levnější HDTV televize označené logem HD Ready.[23] 

2.1.6. Full HDTV 

Rozlišení 1920x1080p. Definuje konkrétní rozlišení počítače nebo televizoru. Písmenko 

p značí slova “progressive scan” neboli neprokládaný obraz. To znamená, ţe jeden 

snímek se skládá z 2,07 milionu obrazových bodů neboli pixelů. Rozlišení je tedy 1920 

x 1080 bodů. Někdy je 1080p označováno jako “plné” HDTV rozlišení. Poměr stran 

je 16:9. Obrovský objem přenášených dat klade obrovské nároky nejen na přenos, 

ale také na zobrazování a především snímání takového obrazu. Nicméně dnešní 

procesory uţ jsou bez problému schopny takový obraz kódovat i dekódovat 

a zobrazovat. Obraz standardu 1080p můţe být zobrazován rychlostí 24, 25 nebo 30 

snímků za sekundu. Při 30 snímcích za sekundu (1080p30) se pak jedná o v současné 

době nejnáročnější zobrazovací kvalitu. Do budoucna se počítá i s frame-rate (počtem 

snímků za sekundu) kolem 50 aţ 60, nicméně to uţ bude nutné pouţívat pokročilé 

kodeky jako H.264/MPEG-4. Televize schopné zobrazovat standard 1080p jsou 

označovány logem “Full HD“. Signál je do nich přenášen pomocí rozhraní DVI 

či HDMI. Všichni výrobci širokoúhlých televizí mají na trhu i modely podporující 

rozlišení 1080p. Jsou nicméně draţší neţ ty, které zvládají pouze 1080i a 720p, ty jsou 

pak označovány pouze logem HD Ready.[23] 
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2.1.7. Barevný model RGB, CMYK a Lab 

RGB 

Písmena zkratky reprezentují tři anglické názvy barev: R (red) – červená, G (green) – 

zelená a B (blue) – modrá. Způsob uţití základních tří sloţek, tedy červené, zelené 

a modré, vychází z aditivního míchání barev. V modelu RGB nejde ale o míchání 

tiskových barev, nýbrţ o míchání tří světel. Sloučením těchto barev dojde k sečtení, 

a tedy k vytvoření bíleho světla. Jedná se tedy o tzv. aditivní model. Nulové hodnoty 

sloţek RGB znamenají absenci světla, a tak vzniká černá barva. Nasazení barevného 

modelu RGB na počítači má své opodstatnění vzhledem k tomu, ţe monitor pracuje 

právě se světlem. Stejně tak zachytává tři barevné sloţky světla i snímač digitálního 

fotoaparátu nebo scanneru.[10] 

CMYK 

I zde slouţí k namíchání určitého odstínu tří základních barev: C (cyan) – azurová, M 

(magenta) – purpurová, Y (yellow) – ţlutá. Na rozdíl od barevného modelu RGB zde jiţ 

uţití spočívá v míchání skutečných barev. Bílou barvu nedostaneme mícháním všech tří 

barev, ale naopak jejich absencí. Bílá je v tisku vlastně nepotištěná plocha papíru. 

Černou barvu bychom tedy logicky měli získat smícháním všech tří barev. Skutečnost 

je ovšem o něco komplikovanější. Dokonale černou barvu tímto způsobem 

nedostaneme, vţdy je výsledkem jen téměř černá s barevným nádechem. Z toho důvodu 

je zde ještě jeden barevný kanál označený písmenem K (black), který reprezentuje 

tiskařskou čerň. Při dopadu světla na vytištěné barvy jsou některé jeho sloţky pohlceny 

a některé odraţeny, proto je model CMY označován jako subtraktivní.[10] 

Logicky si tedy můţeme odvodit, ţe reţim RGB je určen pro zobrazení na monitoru 

a CMYK pro tisk. Rozdíl v paletě zobrazitelných barev najdeme nejen mezi reţimy 

CMYK a RGB, ale i v modifikacích těchto modelů. Pouţití různých pracovních 

prostorů RGB vychází z rozdílů zobrazení na jednotlivých zařízeních. Jiný rozsah barev 

budeme potřeboval při zobrazení obrázků na webu neţ při zpracování pro tiskové účely. 

Z moţností průměrného monitoru vychází prostor sRGB, proto je vhodný 
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pro zpracování obrázků určených k webovým prezentacím. Nejširší rozsah barev nabízí 

prostor Adobe RGB (1998), který je vhodný pro zpracování náročných tiskových 

úloh.[10] 

LAB 

Model vytvořený organizací CIE (Commission Internationale d’Eclairage) vychází 

z fyziologie vnímání lidského oka, kterou napodobuje. Je mezinárodní standard 

pro měření barev. Je navrţen tak, aby byl nezávislý na zařízení. To znamená ţe vytváří 

shodné barvy bez ohledu na konkrétní výstupní zařízení, jako je monitor, tiskárna, 

nebo počítač.[10] 

L = Luminance (světlost) – od 0 (černá) do 100 (bílá). 

A = Sloţka od zelené do červené – od +120 do -120.  

B = Sloţka od modré do ţluté – od +120 do -120. 

2.1.8. Nejpoužívanější formáty pro ukládání grafiky
1
 

AI 

Formát programu Adobe Illustrator. Jedná se o editor vektorové grafiky. 

BMP 

Tento vlastní grafický formát operačního systému Windows často pouţívají prezentační 

programy nebo nachází uplatnění přímo v operačním systému. Obrazové soubory tohoto 

typu nejlépe fungují v prezentacích PowerPointu a některých programech pro práci 

s trojrozměrnou grafikou. 

CDR 

Výchozí formát vektorového editoru Corel Draw. 

                                                 
1
 Informace o formátech sou čerpány ze zdroje [3]. 
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EPS 

Poměrně univerzální formát pro ukládání grafiky. Tento soubor je uloţen ve formátu 

Encapsulated PostScript a lze ho správně vytisknout pouze na postscriptových 

tiskárnách. Bílé plochy ukládá jako průhledné plochy. Vektorová data (fonty, tvary atd.) 

jsou uloţena tak, aby je bylo moţno po importu souboru do jiných aplikací upravit. 

Pouţívá se pro přenos kreseb mezi aplikacemi v jazyce PostScript. Otevřeme-li soubor, 

který je uloţený jako EPS, znovu ve Photoshopu, vektorové prvky v něm budou 

převedeny na rastrové. 

GIF 

Dříve velmi rozšířený formát pro publikování obrázků na webu. Kvalita obrazu 

je ovšem omezena maximálním počtem 265 barev. Není proto vhodný pro fotografie 

nebo sloţitější grafiku s jemnými přechody barev. K lepším vlastnostem formátu GIF 

patří schopnost ukládání více obrázků v jednom souboru. Lze jej tedy vyuţít 

k zobrazení animací. Další výhodou je určení průhledných částí snímku. 

INDD 

Formát dokumentu programu Adobe Indesign. 

JPEG 

Nejrozšířenější formát pro ukládání fotografií a sloţitých obrázků, zejména pro webové 

stránky. Hlavní obliba tohoto formátu spočívá v poměrně účinné kompresi dat. 

Komprese je sice ztrátová, ale při volbě menší kompresní úrovně je formát JPEG 

pouţitelný i pro náročnější tisk. Formát podporuje barevný reţim RGB i CMYK, stupně 

šedi, ale nepodporuje alfa-kanály ani průhlednost. 
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JPEG2000 

Nabízí lepší kompresní algoritmus a obrazovou kvalitu neţ JPEG. Výbornou vlastností 

je moţnost vymezení důleţité oblasti, kde bude pouţita menší míra komprese 

neţ v jiných částech obrazu. Formát podporuje RGB, CMYK a Lab, dokonce i alfa-

kanály nebo 8 bitovou průhlednost. 

PDF 

Univerzální formát určený k zobrazení grafiky. Zobrazuje na základě PostScriptového 

modelu jak vektorová data a písma, tak rastrové grafiky. 

PICT 

Tento formát je vlastním grafickým formátem operačního systému Apple Macintosh. 

Na počítačích platformy Mac má stejné uplatnění jako soubory BMP ve Windows. Na 

počítačích PC se tyto obrázky nemusí vţdy správně zobrazit. 

PNG 

Portable Graphics Network, formát pro přenos dat na síti. Umoţňuje přenesení 

informace do několika skupin. Obraz je nejprve přenesen v hrubých rysech a poté 

vykreslován ve větším detailu. Formát dokáţe plně konkurovat formátu JPEG. 

PSD 

Formát programu Adobe Photoshop zachovává všechny podstatné funkce a nastavení, 

jako např. vrstvy, alfa-kanály a podobně. Data v něm vůbec nejsou komprimována. 

Tento formát podporují i jiné programy od společnosti Adobe. 

QXD 

Dokument programu Quark Express specializovaného na sazbu. 
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SVG 

Formát vektorové grafiky určený zejména pro webové aplikace. 

SWF 

Formát animované grafiky určené pro webové nebo multimediální prezentace. 

Pro přehrání slouţí zásuvný modul Adobe Flash player. Dokáţe pracovat 

jak s vektorovou grafikou, tak i s rastrovými obrázky. 

TIFF 

Tento formát lze bez problémů pouţít v sázecích programech i programech pro úpravu 

obrázků na různých operačních systémech. Obrázky je v něm moţné ukládat i 

s vrstvami, ale soubory jsou pak větší. 

2.2. 3D grafika 

Třetí rozměr je v počítačové grafice vyuţíván v řadě aplikací. Hlavním vyuţitím jsou 

vizualizace designu průmyslových výrobků a herní a filmový průmysl. Stále více 

proniká i do vědeckých oborů, jako je lékařství, genetické inţenýrství, simulace 

a mnoho dalších. Programy pro 3D grafiku jsou samozřejmě skvělým pomocníkem 

pro vytváření ilustrací, animací a grafických prvků. Mezi nejrozšířenější 3D modelovací 

programy patří 3D Studio Max (3ds max), Maya, Cinema, Lightwave, Rhinoceros. 

Ve strojírenství jsou pouţívány programy Autocad, Autodesk Inventor a další, 

umoţňující vedle simulace fyziky i vizualizaci navrţených výrobků. V architektuře je, 

zejména ve světovém měřítku, nejvíce pouţíván program ArchiCad. Přestoţe jsou 

schopnosti nejvíce pouţívaných 3D modelovacích programů vcelku vyrovnané, drobné 

specializace je předurčují k větší či menší oblibě v konkrétních oborech. Program Maya 

je tak díky dobré výbavě pro animaci a efekty hojně vyuţíván ve filmovém průmyslu. 

Nejrozšířenějším a poměrně univerzálním je 3ds max.[8] 
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Pokud nechceme investovat nemalou sumu peněz do profesionálních programů a stačí 

nám jen základní nástroje, pak si můţeme zdarma stáhnout program Blender na webu 

www.blender.org. Vzhledem k tomu, ţe se jedná o freeware, je tento program poměrně 

dobře vybaven. Na jeho ovládání je však potřeba si zvyknout. Nedílnou součástí 3D 

grafických programů jsou další programy a plug-iny pro specializované úlohy. Řada 

programů se specializuje na renderování vytvořené scény, patří sem například Vray. 

Dříve bylo jejich pouţití nevyhnutelností, dnes jiţ bývají stále více dodávány v rámci 

samotného 3D grafického programu. Na úrovni algoritmů programů pro renderování 

závisí přesvědčivost realismu a také rychlost vykreslení dané scény zvolenou metodou.  

Příklad renderování pomocí programu Vray v 3ds max uvádím v příloze č. 7 model 

vesmírné lodi ve stylu LEGO, který jsem vytvořil během studia jako semestrální práci 

v předmětu „Základy počítačové grafiky“. Abych dosáhl jisté úrovně realističnosti, 

trvalo mi samotné renderování něco přes 62 hodin. 

Jednou z významných činností při tvorbě 3D grafiky je vytváření a mapování textur. 

Textura je obrázek, kterým je „pokryto“ těleso. V nejjednodušší formě jsou textury 

pouţívány pro obarvení modelu, ale na tělese můţe být více vrstev textur, které určují 

například i průhlednost či lesklost v daném bodě na povrchu. Pomocí textur je moţné 

dosáhnout velmi dobrých výsledků a vysoké úrovně detailu při pouţití relativně 

jednoduchého modelu. Kaţdý bod na povrchu tělesa má potom kromě souřadnic X, Y, 

Z (určující polohu bodu v prostoru) ještě 2 souřadnice označované většinou jako U a V, 

které určují umístění textury na daném místě. Proces umísťování textury na povrch 

tělesa se proto často nazývá „UV mapování“.[5] 

Animace je dalším pojmem v 3D grafice. Nerozumí se však pouze samotný pohyb 

objektů, ale i definice zdrojů světla, úhlu pohledu kamery, barev a dalších prvků, 

které se mohou měnit v čase. Nejjednodušší metoda animace zvaná keyframing 

je zaloţená na stejném principu jako klasická 2D počítačová animace. Spočívá 

v definování klíčových „mezních“ pozic, mezi kterými potom počítač vytvoří plynulý 

přechod. Animace postav a mechanických zařízení je ve 3D grafice často zaloţena 

na animaci kostry modelu. Stejně jako skutečný ţivý organismus i 3D model má kostru 

a jednotlivým částem modelu se určí, ke které kosti náleţí. Pokročilé 3D grafické 
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nástroje usnadňují animaci kostry díky technice zvané inverzní kinematika. Na rozdíl 

od klasické animace kostry, kdy animátor určuje úhly všech kloubů, stačí při pouţití 

inverzní kinematiky určit pozici několika klíčových částí kostry a polohy kloubů jsou 

dopočítány algoritmicky. Existuje mnoho dalších technik animace, které se vyuţívají 

ve 3D grafice. Některé programy umoţňují animaci na základě simulace fyzikálních 

jevů jako je gravitace, pohyb vodní hladiny a podobně. Pro velmi realistickou animaci 

postav se zase vyuţívá technologie motion capture, kdy je pomocí speciálního zařízení 

zachycen pohyb ţivého herce a nahraná data jsou potom aplikována na 3D model 

postavy.[5] 

Dalším pojem vyskytující se v 3D grafice, o kterém jsem psal výše je tzv. rendering. 

Jedná se o vykreslení dvourozměrného obrazu na základě modelu scény. S renderingem 

je spojeno i několik vlastností. Patří sem například
2
: 

 Bump mapping – metoda napodobující drobné nerovnosti povrchu 

 Difrakce – ohyb, šíření a interference paprsků na hranách objektů 

 Hloubka ostrosti – objekty vzdálené od objektu v centru pozornosti se jeví 

nezaostřené 

 Kaustika – forma nepřímého osvětlení, světelné paprsky odraţené nebo lomené 

nějakým objektem 

 Měkké stíny – různé úrovně osvětlení způsobené částečně zakrytými světelnými 

zdroji 

 Mlha – tlumení světla při průchodu atmosférou 

 Nefotorealistické zobrazování – vykreslování scény v uměleckém stylu, 

který má připomínat malování nebo kreslení 

 Nepřímé osvětlení – plochy, které jsou osvětleny odrazy z jiných ploch, nikoli 

přímo od zdroje světla 

 Odraz světla – zrcadlové nebo velmi lesklé reflexe 

 Pohybové rozostření – rychle pohybující se objekty se jeví rozmazané 

 Průhlednost – šíření světla skrze objekty bez zkreslení 

 Průsvitnost – šíření světla skrze objekty se zkreslením 

                                                 
2
 Pojmy jsou čerpány ze zdroje [1]. 
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 Refrakce – ohyb světla spojený se šířením světla skrze objekty 

 Stínování – kolísání barvy a jasu povrchu v závislosti na osvětlení 

 Stíny – důsledek zakrytí zdroje světla jiným objektem 

 Texturování – dodání realistického vzhledu povrchu modelu 

Pro realistický vzhled scény je potřeba simulovat především šíření a rozptyl světla 

v celé scéně – globální osvětlení. Dva nejznámější algoritmy jsou: 

 Sledování paprsku – je metoda zaloţená na zpětném sledování paprsku 

vycházejícího z oka pozorovatele a jeho kolizí s tělesy ve scéně. Dobře simuluje 

ostré stíny, zrcadlové odrazy (i vícenásobné) a průhledné objekty. Algoritmus 

neposkytuje fotorealistický výstup a příliš se nehodí pro simulaci v reálném 

čase. 

 Radiozita – je metoda vyuţívající fyzikální zákony o šíření energie v prostoru. 

Je vhodná k simulování nepřímého (odraţeného) osvětlení ve scéně s matnými 

povrchy. Nedokáţe pracovat s průhlednými objekty a zrcadly. Scéna musí být 

reprezentována polygonálním modelem. 

3D modelovací programy mají mnoho různých formátů ukládání. Jedním z nich 

je formát Collada, který vyuţívám při realizaci návrhu, proto by bylo dobré se o něm 

něco dozvědět. 

2.2.1. Formát Collada 

Collada byla vytvořena firmou Sony Computer Entertainment jako oficiální formát 

pro PlayStation 3 a PlayStation Portable. Tato zkratka znamená COLLAborative 

Design Activity a představuje formát pro ukládání 3D objektů a animací. Je zaloţena 

na otevřeném XML schématu, tj. můţeme ji snadno přečíst, vytvářet a editovat 

v libovolném textovém editoru. Obvykle pouţívá koncovku *.dae. Colladu je moţné 

buď standardně, nebo pomocí plug-inů, pouţívat v programech Maya, 3ds Max, 

LightWave 3D, Maxon|Cinema 4D R11, Softimage|XSI, Side Effect's Houdini, 
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MeshLab, SketchUp, Blender a dalších. Collada je pouţívána jako výchozí 3D formát 

v programu Google Earth (s příponou *.kmz).[17] 

2.2.2. DirectX 11 – s čím přichází nová verze 

Poslední verze DirectX 11 je jiţ v počítačové sféře delší dobu. Pro ty, kteří pořád ještě 

nevědí, v čem je lepší neţ její předchůdci, zde shrneme základní rysy. Prvním 

a nejznámějším je zřejmě tzv. teselace, která umoţňuje generovat komplikovanější 

modely s daleko více vrcholy a tím pádem detaily. Přitom se na grafickou kartu posílá 

pouze několik málo vrcholů a ostatní jsou dopočítány přímo na ní. Navíc se jedná 

o systém, který dovoluje měnit měřítko, takţe můţete udávat přímo úroveň teselace. 

To znamená, ţe kdyţ se budete přibliţovat k objektu, bude se měnit zobrazování detailů 

na něm od ţádných aţ po maximální. Dalším vylepšením je moţnost lépe pracovat 

s tzv. GPGPU. To značí všeobecné pouţívání GPU, nejen pro hry a multimediální 

aplikace. Jedná se o pouţití v počítačovém vidění při segmentaci dat, při rozpoznávání 

řeči, ale například i v kryptografii, počítačových databázích nebo finančnictví. 

Posledním předním rysem nejnovější verze je multithreading. Jedná se o vyuţívání CPU 

pro sekundární výpočty grafiky. Procesory nejsou sice příliš uzpůsobeny na takové 

výpočty, ale i tak jde o zrychlení. Dalšími efekty jsou například hloubka ostrosti, lepší 

zpracování sloţitější průhlednosti nebo lepší měkké stíny.[29] 

2.3. Flash 

S technologii flash se seznámil snad kaţdý uţivatel internetu. Díky flashy 

a scriptovacímu jazyku actionscript v současné době ve verzi 3, můţeme vytvářet 

interaktivní webové prezentace. Podobně jak je tomu v jiných programovacích jazycích 

i tento jazyk pracuje s objekty, třídami, metodami a vlastnostmi. V současnosti se také 

objevují rozšiřující knihovny pro jazyk actionscript, jako například Papervision3D, 

Away3D aj., které přidávají nové funkce otvírající nové moţnosti, díky kterým můţeme 

dosáhnout neuvěřitelných vizualizací a efektů. Právě tyto knihovny pouţiji i k realizaci 

svých návrhů. 
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Nejnovější verze programu slouţícímu k tvorbě flash prezentací je Adobe Flash CS5, 

který výrazně vylepšuje některé zjevné nedostatky například v podobě práce s textem, 

rozšiřuje manipulaci s videem a navyšuje komfort úprav skriptů v dodávané aplikaci 

Flash Builder. Adobe Flash CS5 navíc zdaleka není jen grafický editor se schopností 

kreslit, upravovat a navzájem propojovat vektorovou a bitmapovou grafiku, nýbrţ 

současně i výkonný vývojářský prostředník při tvorbě a především designu Flash 

aplikací a multimediálních projektů. Flash CS5 tak vlastně elegantně propojuje 

vývojářské platformy a technologie Adobe Flex/Flash Builder/AIR, jejichţ výstupem 

můţe být prakticky libovolný multimediální interaktivní obsah obalený grafickým 

rozhraním, to vše navíc hezky pohromadě na stejné platformě.[25] 
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3. Analýza řešeného problému 

Kaţdodenních internetových uţivatelů rok od roku přibývá. Z grafu č. 1 si můţeme 

všimnout, ţe hodnota se od roku 2005 do roku 2009 zvýšila přibliţně o dva milióny. 

Stejně tak vzrostla hodnota uţivatelů vyhledávajících informace o zboţí a sluţbách 

(graf č. 2). 

 

Graf 1: Jednotlivci, kteří použili osobní počítač v posledních 3 měsících každý nebo téměř každý den.  

Zdroj: ČSÚ [18]. 

 

Graf 2: Použití internetu v posledních 3 měsících - vyhledávání informací o zboží a službách.  

Zdroj: ČSÚ [18]. 
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Logicky tak narostla hodnota uţivatelů nakupujících přes internet (graf č. 3). 

Zajímavostí je, ţe velká část počtu prodaných produktů lehce roste nebo se drţí téměř 

stejné hodnoty, zatím co prodej produktů kategorie hračky a stolní hry se jen 

za poslední tři roky téměř ztrojnásobil (graf č. 4). Proto ve vlastním řešení navrhnu dva 

3D modely hraček – zvíře a model vesmírné lodě. 

 

Graf 3: Jedinci, kteří v posledních 12 měsících nakoupili přes internet.  

Zdroj: ČSÚ [18]. 

 

Graf 4: Zboží nakoupené pro soukromé účely v posledních 12 měsících přes internet - hračky, stolní hry. 

Zdroj: ČSÚ [18]. 
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Následující grafy (graf 5 aţ 8) zobrazují další zboţí nakoupené přes internet 

pro soukromé účely. Konkrétně se jedná o produkty, na které by bylo moţné aplikovat 

třídimenzionální zobrazení. Proto neuvádím produkty a sluţby jako prodej letenek, 

vstupenky na sportovní a kulturni akce aj. 

 

Graf 5: Zboží nakoupené pro soukromé účely v posledních 12 měsících přes internet - počítače a počítačový 

hardware.  

Zdroj: ČSÚ [18]. 

 

Graf 6:  Zboží nakoupené pro soukromé účely v posledních 12 měsících přes internet - mobilní telefony 

a jejich příslušenství.  

Zdroj: ČSÚ [18]. 
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Graf 7: Zboží nakoupené pro soukromé účely v posledních 12 měsících přes internet - elektronika (TV, DVD, 

video, audio, kancelářská technika atd.).  

Zdroj: ČSÚ [18]. 

 

Graf 8: Zboží nakoupené pro soukromé účely v posledních 12 měsících přes internet - bílá technika 

a elektrospotřebiče pro domácnost (lednice, pračky, myčky atd.).  

Zdroj: ČSÚ [18]. 

Mimo elektroniky, hardwaru, mobilních zařízení atd., by bylo moţné pouţít 3D model 

i na produkty typu obuv, sportovní potřeby, fotoaparáty, videokamery, filmy, hudby, 

knih a mnohých dalších výrobků. Grafy těchto výrobků jsou uvedeny níţe. 
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Graf 9: Zboží nakoupené pro soukromé účely v posledních 12 měsících přes internet - fotoaparáty, 

videokamery a jejich příslušenství.  

Zdroj: ČSÚ [18]. 

 

Graf 10: Zboží nakoupené pro soukromé účely v posledních 12 měsících přes internet - oblečení, obuv, módní 

doplňky.  

Zdroj: ČSÚ [18]. 

0

20 000

40 000

60 000

80 000

100 000

120 000

140 000

160 000

180 000

2007 2008 2009

U
ži

va
te

lé

Roky

0

100 000

200 000

300 000

400 000

500 000

600 000

700 000

2007 2008 2009

U
ži

va
te

lé

Roky



 

 

- 35 - 

 

 

Graf 11: Zboží nakoupené pro soukromé účely v posledních 12 měsících přes internet - filmy, hudba.  

Zdroj: ČSÚ [18]. 

Většina dnešních e-shopů vyuţívá dvoudimenzionální pohled pro prezentaci výrobků. 

Ti, kteří pouţívají třídimenzionální, vyuţívají nejčastěji různých přídavných programů 

jako java nebo jiné aplikace, které umoţní 3D pohled produktu. Zde můţe nastat 

problém, protoţe kaţdý uţivatel si nemusí vědět rady jak tyto programy například 

nainstalovat. Následující SWOT analýza zobrazuje současný stav produktů v e-shopech. 

 

Obrázek 1: SWOT analýza produktů v e-shopu. 

Zdroj: vlastní. 
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Tabulka 1: Strategie SWOT analýzy. 

Zdroj: vlastní. 

 Silné stránky – S Slabé stránky – W 

Příležitosti – O 

SO strategie WO strategie 

Vyuţít dobré kompatibility flash 

a nových technologií k navrţení 

3D modelu a 3D banneru. 

Sníţit nutnost pouţití 

podpůrných programů 

k zobrazení 3D produktů. 

Hrozby – T 

ST strategie WT strategie 

Pouţít flash k sestrojení 3D 

modelu a 3D banneru a sníţit tak 

moţné potíţe s kompatibilitou. 

Pouţít pouze flash plug-in, které 

je součástí prohlíţeče a zamezit 

potíţe s kompatibilitou. 

 

Na základě strategií SWOT analýzy navrhnu za pomocí tzv. freeware programu 

FlashDevelop a přídavných knihoven pro jazyk flash umoţňující 3D zobrazení objektů 

ve flashy, 3D banner a 3D model převedený do webového formátu flash, který vyuţiji 

k návrhu 3D katalogu. Díky technologii flash, který se stal v současné době téměř 

standardem všech internetových prohlíţečů, zamezit problémy s kompatibilitou 

a zobrazením. 
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4. Návrh řešení problému 

Nejprve je nutné obstarat několik potřebných programů, díky nimţ mohu realizovat 

svoji práci. Nejedná se pouze o běţný software, ale také o rozšiřující knihovny 

pro flash, tzn. jazyk actionscript třetí verze (AS3), především se jedná o rozšiřující 

knihovny podporující třetí dimenzi nebo jinak řečeno 3D engine. 

4.1. Použité programy (software) 

Software pouţívaný při realizaci je zdarma (free). Jmenuje se FlashDeveloper 

a je moţné jej stáhnout například z webu FlashDevelop [19] ve verzi 3.0.6 RTM. 

Nejedná se ovšem o jediný moţný a pouţitelný software, mimo programu FlashDevelop 

lze vyuţít například Flex Builder 3 společnosti Adobe. Představuje skutečně účinný 

nástroj poskytující velké mnoţství funkcí a operací, ovšem volně ke staţení je pouze 

jeho časově omezená (trial) verze.  

Společnost Adobe myslela i na běţné uţivatele a vytvořila sadu vývojářských nástrojů, 

které je moţné pouţít k tvorbě aplikací pro daný software. Mým softwarem 

je jiţ zmiňovaný FlashDevelop a sada vývojářských nástrojů, které nosí označení 

FlexSDK a tvoří nedílnou součást pro aplikaci FlashDevelop. Sadu nástrojů (FlexSDK) 

se nachází na stránkách společnosti Adobe [12] ve verzi 3.5 o velikosti přibliţně 

120MB. 

Existuje i celá řada dalších placených nebo volně staţitelných softwarů podporující 

jazyk actionscript s moţností propojení s podpůrnými knihovnami (3D enginem) 

například MiniBuilder, Adobe Flash ve verzi CS5 a jiné. 

Posledním programem v mojí práci je TortoiseSVN, vynikající grafický nástroj 

pro Windows slouţící k práci s verzovacím systémem SVN (Subversion). Integruje 

se do Windows kontextové nabídky, ze které můţeme spouštět všechny potřebné funkce 

včetně grafického porovnávání souborů, pokud dojde ke kolizi různých verzí dat. 

Tato verze je zaloţena na verzi Subversion 1.6.7. [28] 
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Abych shrnul tuto část problematiky, vytvořil jsem tabulku obsahující nezbytné 

programy potřebné pro realizaci projektu a to i s programy, které by měly být standardní 

součástí programového vybavení pro správné fungování FlashDevelop. 

Tabulka 2: Potřebný software.  

Zdroj: vlastní. 

Název Volně stažitelné z  

Adobe flash player http://get.adobe.com/flashplayer/ 

Java http://www.java.com/en/download/inc/windows_upgrade_xpi.jsp 

FlashDevelop http://www.flashdevelop.org/community/viewforum.php?f=11 

Flash SDK http://www.adobe.com/cfusion/entitlement/index.cfm?e=flex3sdk 

TortoiseSVN http://tortoisesvn.net/downloads 

 

4.2. Použité knihovny (3D engine) 

Další nepostradatelnou kategorií, bez které by nebylo moţné realizovat 3D efekty 

ve flashy, jsou 3D knihovny. Existuje velké mnoţství těchto pomocných knihoven 

od různých výrobců specializujících se na různé funkce a efekty např. pohyb, rotace, 

naklonění apod. Ve své práci vyuţívám knihovny – AsWing, Away3D, Papervision3D 

a TweenLite od skupiny GreenSock. 

První knihovna je dostupná z webu AsWing [14] ,kde lze stáhnou mimo knihovny také 

i tzv. GUIBuilder, coţ je samostatný software přímo pro práci s jazykem actionscript3 

a knihovnou AsWing. Mně však postačí jen knihovna. Pouţiji verzi 

aswing_a3_1.3_allinone. 

Away3D, knihovna podporující třetí dimenzi. Na první pohled moţná neznámý název, 

avšak měsíčně se s ním setkává přibliţně 23 milionů lidí [24] (toto číslo stále roste) 

na sociální síti Facebook pod názvem Café World. Tato hra byla vytvořena právě 
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za pomocí knihoven Away3D. Nejnovější verze Away3D Lite version 1.0 dostupná 

z webu Away3D [16] . Je zde moţnost vyuţití systému SVN. Tento program funguje 

za pomocí výše zmiňovaného softwaru TortoiseSVN, který umoţňuje stáhnout 

nejnovější a opravené soubory přímo z odkazu „http://away3d.googlecode.com/svn“. 

Tuto techniku převedu v další části práce. 

Asi nejoblíbenějším 3D enginem mezi flash vývojáři se stal Papervision3D, který nejen 

podporuje 3D prostředí s různými efekty, ale i importování jiţ vyrenderovaných 3D 

objektů z jiných 3D grafických programů (Blender, 3D studio Max a jiné). Tento 

program se stal skutečně nepostradatelným nástrojem pro 3D weby budoucnosti. 

Nejnovější verze je dostupná z webu Papervision3D [26] nebo opět pomocí programu 

TortoiseSVN, kde lze získat nejnovější soubory z adresy 

„http://papervision3d.googlecode.com/svn/trunk/“. 

TweenLite, poslední z těchto knihoven se zabývá hlavně efekty textů a pohybem 

objektů. Jeho moţnosti vyuţiji v jedné z pozdějších demonstrací při tvorbě 

3D reklamního banneru. Verzi TweenLite lze stáhnout z webu Greensock [22]. 

Tabulka 3: Potřebné knihovny (3D engine).  

Zdroj: vlastní. 

Název Volně stažitelné z  

AsWing http://code.google.com/p/aswing/ 

Away3D http://away3d.com/downloads 

Papervision3D http://code.google.com/p/papervision3d/downloads/list 

TweenLite http://www.greensock.com/tweenlite/ 
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4.3. Instalace softwaru 

4.3.1. FlexSDK 

Nejprve spustím FlexSDK zip soubor. Obsah souboru zkopíruji do vytvořené sloţky 

na disku „C:\FlexSDK\“. V dalším kroku nainstaluji FlashDevelop a propojím 

oba programy. 

4.3.2. FlashDevelop 

Spustím instalaci z příslušného souboru, aţ se objeví instalační okno viz. Obrázek 2. 

 

Obrázek 2: Instalace FlashDevelop.  

Zdroj: vlastní. 
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Příjmu licenční podmínky. V komponentech, které chci nainstalovat zvolím advance 

a přidám komponent Multi Instance Mode viz. Obrázek 3. 

 

Obrázek 3: Komponenty FlashDevelop.  

Zdroj: vlastní. 

 

Po instalaci spustím program, abych jej mohl propojit s FlexSDK. V Menu Tools 

vyberu Program Settings. V levém menu zvolím AS3Context a změním Flex SDK 

Location na C:\FlexSDK viz. Obrázek 4. 
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Obrázek 4: Propojení programů.  

Zdroj: vlastní. 

 

4.3.3. TortoiseSVN 

Nainstaluji poslední potřebnou aplikaci pro práci s knihovnami. Klasickým dvojklikem 

spustím instalaci softwaru. Ponechám defaultní cestu instalovaného programu 

a dokončím instalaci. Další kapitola je věnována staţení knihovny pro FlashDevelop 

právě pomocí tohoto programu. 

 

 

 



 

 

- 43 - 

 

4.4. Propojení knihoven s FlashDevelop 

4.4.1. Stažení knihovny pomocí TortoiseSVN 

V první řadě, neţ začnu se stahováním knihovny, vytvořím si na disku sloţku. Ta bude 

slouţit jako centrum pro všechny knihovny a projekty. Na názvu nikterak nezáleţí, 

já si zvolil název MyProjects. 

V této sloţce vytvořím další pojmenovanou pv3d-svn. Z webové adresy 

http://code.google.com/p/papervision3d/source/checkout zkopíruji odkaz pod nadpisem 

Command-line access viz. Obrázek 5. 

 

Obrázek 5: Odkaz pro pv3d-svn.  

Zdroj: vlastní. 

Pravým kliknutím myši na sloţku pv3d-svn se v kontextovém menu přidala funkce 

SVN Checkout… viz. Obrázek 6. 
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Obrázek 6: Kontextové menu.  

Zdroj: vlastní. 

Zvolím tuto volbu. Do kolonky URL of repository vloţím zkopírovanou webovou 

adresu uvedenou na obrázku č. 5. Potvrzením tlačítka OK se zahájí stahování knihoven 

Papervision3D. 

 

Obrázek 7: SVN checkout.  

Zdroj: vlastní. 
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Po úspěšném dokončení stahování vytvořím ve sloţce MyProjects další sloţku 

pojmenovanou pv3d-library. Ta bude finální knihovnou Papervision3D 

pro FlashDevelop. Ovšem nutné je ji naplnit správnými daty. Ty získám právě ze sloţky 

pv3d-svn. Nevyuţiji ale celý obsah sloţky, nýbrţ jen část. Do sloţky pv3d-library 

zkopíruji sloţku src, která se nachází v adresáři MyProjects\pv3d-svn\as3\trunk. Touto 

operací bylo docíleno úspěšného nastavení knihovny. 

Zbylé knihovny AsWing, Away3D a TweenLite stačí stáhnout z webových adres 

uvedených v tabulce 2. Obsahy těchto knihoven zkopírovat pod patřičným názvem 

do sloţky MyProjects. 

Následující kapitola je věnována aplikaci FlashDevelop, který pouţiji pro projektování 

svých návrhů. 

4.4.2. Interface FlashDevelop 

V aplikaci vyuţiji tři základní okna: 

 Input, 

 output, 

 project. 

Input okno slouţí k psaní zdrojových kódů jednotlivých souborů zpravidla 

s koncovkou *.as. Programování je podobné jako u jiných programovacích jazyků. 

Osahují zdrojové knihovny, veřejné a privátní proměnné, funkce if/else, for aj. Kaţdý 

soubor *.as začíná tagem package {…} například: 

package { 

 import org.papervision3d.objects.DisplayObject3D; 

 public class TweenRotating extends BasicView 

  { 

  [Embed(source="assets/obrazek1.jpg")] 

  private var asset1:Class; 
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  public function TweenRotatingPlanesToYou() 

   { 

   addChildAt(new background(), 0);    

   } 

  } 

 } 

Při spouštění nebo testování zdrojového kódu mohou nastat chyby. K detekování 

takových chyb pomáhá okno Output. Nalezenou chybu zvýrazní a zobrazí číslo řádku, 

na kterém se nachází. 

Nakonec je zde okno Project slouţící k hierarchickému uspořádání všech souborů, 

sloţek a knihoven pouţitých pro daný projekt viz. Obrázek 8. Knihovny je nutno 

ke kaţdému projektu přiřadit. Přiřazení se provádí přes menu Project > Properties… 

záloţka Classpaths. Tlačítkem Add Classpath… vloţíme cestu k vyţadované knihovně 

viz. Obrázek 9. 

 

Obrázek 9: Nastavení cest.  

Zdroj: vlastní. 

Obrázek 8: Okno Project.  

Zdroj: vlastní 
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4.5. Tvorba 3D banneru 

Základní myšlenku 3D banneru si lze představit jako Zemi, kolem které obíhají náhodně 

vygenerované planetky. Uţivatel zaujímá místo z pohledu Země a náhodně 

vygenerované planety jsou jednotlivé nahrané fotografie. Při kliknutí na libovolnou 

fotografii dojde k přiblíţení objektu. Opakovaným kliknutím dojde k opačnému efektu 

a objekt se vrátí na své místo. 

Ve FlashDevelop pomocí menu Project > New project… zvolím ActionScript 3 

a Empty project. Pouţívané knihovny jsou Papervision3D a TweenLite. Cestu provedu 

přes menu Project > Properties… záloţka Classpaths viz. Obrázek 8. V okně Project 

pravým kliknutím myši na název projektu a zvolím Add > New Class… Přidám dvě 

třídy pojmenované CustomPlane.as a TweenRotatingPlaneToYou.as. Zobrazím 

kontextové menu pravým kliknutím myši na druhou třídu a zvolím vlastnost Allways 

Compile. Tím jsem zvolil klíčový soubor projektu. Také vytvořím sloţku nazvanou 

assets slouţící jako úloţiště pro fotografie produktů. Celé zdrojové kódy [20] obou 

souborů *.as jsou uvedeny v příloze č. 5. Ze zdrojového kódu třídy 

TweenRotatingPlaneToYou.as je několik řádků, které se dají upravovat a to konkrétně: 

[SWF(backgroundColor="#555555", frameRate="30", width="900", height="480")] 

Zde je moţné nastavit šířku, výšku, počet oken za vteřinu a defaultní barvu pozadí. 

Pro svůj projekt volím právě toto nastavení výšky a šířky okna. 

  [Embed(source="assets/foto1.jpg")] 

  private var asset1:Class; 

  [Embed(source="assets/foto-n.jpg")] 

  private var asset-n:Class; 

Výše uvedené řádky kódu sloţí pro načtení fotek ze sloţky a následnému přiřazení 

do proměnné asset1. Proměnných můţe být více, ale je nezbytné je připsat do pole 

(Array), které má syntaxi: 
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private var planeAssets:Array = [asset1, asset2, asset-n…]; 

Posledním kódem ovlivňující výsledný efekt 3D banneru je: 

var plane:CustomPlane = new CustomPlane(planeMaterial, 900, 480); 

Jedná se o velikost fotografie v přiblíţeném reţimu (při kliknutí na fotografii). Jestliţe 

tedy budu uvaţovat o výsledné velikosti okna 900x480px (šířka x výška) a fotografii 

s konečným přiblíţením o stejné velikosti, pokryje při přiblíţení fotografie celou plochu 

okna. Z toho plyne, ţe velikost tohoto přiblíţení by neměla přesáhnout velikost okna.  

K návrhu 3D banneru vyuţiji tři kategorie po pěti fotografiích. První kategorie obsahuje 

klasické fotografie produktů ve formátu *.jpg (fotografie ţidlí). V druhé kategorii jsou 

fotky notebooků a jiných produktů ve formátu *.png s transparentním pozadím. 

Obě ukázky slouţí jako komerční vyuţití. Poslední kategorie jsou fotky pro domácí 

nekomerční vyuţití. 

Výsledná animace je zobrazena na obrázku č.10 a při kliknutí na obrázku č.11 

demonstrované na 3D banneru pro domácí vyuţití jako fotoalbum např. pro blog. 

Výstupní soubor je ve formátu flash (*.swf). 
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Obrázek 10: 3D banner - fotoalbum. 

Zdroj: vlastní. 

 

Obrázek 11: 3D banner po kliknutí na fotografii.  

Zdroj: vlastní. 
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4.6. Tvorba 3D modelu 

Klíčem vytvoření 3D modelu ve FlashDevelop je vyuţití knihovny papervision3D. Dále 

je zapotřebí vytvořený model v 3D grafickém programu např. 3DstudioMax, Blender, 

Maya, Google SketchUp aj. a textura modelu ve formátu *.jpg, *.png, *.gif nebo *.tga. 

Vytvořený model musí být ve formátu *.dae neboli collada. V návrhu pouţiji dva 

modely, které jsou součásti 3D knihovny. Model zvířete a vesmírné lodi. 

Stejně jako u tvorby 3D banneru, začnu vytvořením nového projektu přes menu 

Project >New project… Zvolím Empty project a načtu knihovnu Papervision3D. 

Součástí je i jedna třída nazvaná Main.as obsahující zdrojový kód [20]. Vytvořím 

sloţku daeModel, do které vloţím modely ve formátu *.dae a jejich textury. Celý 

zdrojový kód souboru Main.as je v příloze č. 6. Za zmínku stojí několik řádků kódu, 

které lze editovat a upravit tak výslednou vizualizaci objektu např.: 

bitmapFileMaterial  = new BitmapFileMaterial("daeModel/Cow.jpg"); 

cow = new Collada("daeModel/cow.dae",materialList); 

Tyto části kódu načtou texturu do proměnné a přiřadí do proměnné collada model. 

   cow.moveDown(350); 

   cow.scale = 4; 

   cow.pitch( -10); 

Příkazy moveDown, scale, pitch slouţí k manipulaci s objektem po ose y, zvětšení nebo 

zmenšení původní velikosti objektu (scale). 

cow.rotationY = stage.mouseX / sceneWidth * 360 

cow.rotationX = stage.mouseY / sceneWidth * 360 

Rotace objektu po ose x nebo ose y se provádí přes příkaz rotation. Pokud budu tedy 

přejíţdět kurzorem přes objekt, bude se otáčet podle umístění kurzoru myši. Celý 

princip načtení zachycuje následující obrázek č. 12. 
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Obrázek 12: Načtení textury a collada modelu. 

Zdroj: vlastní. 

Výstupem projektu je taktéţ jako u 3D banneru soubor s koncovkou *.swf. Tento 

soubor na rozdíl od předchozího návrhu nestačí. Jestliţe budu chtít 3D model vloţit 

na internet je nutné spolu s flash souborem zkopírovat na ftp server i sloţku s modely 

a texturami, které načítám. Důleţité je i zachování stejné hierarchie souborů 

viz. obrázek č.13. 
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Obrázek 13: Hierarchie souborů.  

Zdroj: vlastní. 
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5. Zhodnocení návrhu 

5.1. 3D banner 

Navrţený interaktivní 3D reklamní banner lze uplatnit v komerčním, ale i nekomerčním 

prostředí. Například jako mini fotoalbum v hlavičce blogu, osobních nebo jiných 

webových stránek. 

5.1.1. Možnosti využití 

KOMERČNÍ 

 Jako úvodní stránka e-shopu, 

 upozornění na slevy nebo akce produktů, 

 zobrazit novinky v e-shopu. 

Pouţitím této moderní technologie je cílem zaujmout a překvapit potencionálního 

zákazníka a získat si jeho sympatie. To je hlavním úkolem 3D banneru v komerčním 

prostředí. Zůstat „In“ a jít s dobou nebo ještě lépe ji předběhnout. 

NEKOMERČNÍ 

Mám své osobní webové stránky obsahující fotografie, které chci představit svým 

blízkým a přátelům. Ovšem chci něco nového a moderního. Něco co moji známí 

na svém webu nemají. Například interaktivní fotoalbum, kterým je překvapím 

a ohromím. I k tomuto mohu pouţít navrţený 3D banner. 

5.1.2. Náklady 

Programové vybavení, které pouţívám pro zkonstruování 3D banneru je opensource, 

proto jsou tedy náklady nulové. Je zde i moţnost placených programů namísto 

FlashDevelop. Podobně je tomu i u grafických programů pro úpravu fotek. Následující 

tabulka zahrnuje ceny některých takových aplikací, ale jejich koupě není nutná. 
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Tabulka 4: Ceny ostatních aplikací. 

Zdroj: vlastní.3 

Pro práci s AS3 Cena Pro práci s fotografií Cena 

Adobe flash 

profesional CS5 
699USD Photoshop CS5 833.69 € 

Flash builder 4 

premium Edition 
699USD 

Photoshop CS5 

Extended 
1 208.79 € 

Flash builder 4 

Standard Edition 
249USD   

 

5.2. 3D model 

5.2.1. Důvody využití 

Umoţnit třídimenzionální pohled na produkt současnému nebo potencionálnímu 

zákazníkovi, zlepšit úroveň nakupování, odlišit se od ostatních prodejců, zvýšení kvality 

sluţeb, zaujmout, zvýšit návštěvnost a zisk e-shopu, to a mnoho dalších důvodu vede 

k vyuţití navrhovaného řešení. 

5.2.2. Náklady 

Pokud chci realizovat tuto technologii pro e-shop, je potřeba vynaloţit určité finanční 

prostředky. Ne však na aplikace pouţité v návrhu, ale 3D grafický program pro tvorbu 

modelů collada. Existují tři varianty jak získat hotové modely: 

 Pomocí jednoho z mála free 3D grafických programů Blender. 

 nákupem 3D grafické aplikace, 

 vyuţitím externí firmy k vytváření 3D modelů. 

 

                                                 
3
 Ceny uvedené v tabulce č. 4 jsou webové adresy společnosti Adobe [13]. 
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VARIANTA A – BLENDER 

Blender je 3D grafický volně šiřitelný program slouţící k tvorbě 3D grafických modelů, 

animací, scén a jiných objektů. Samotný software nedokáţe ukládat modely ve formátu 

*.dae (collada) , ale je zapotřebí přídavné utility (plug-in), který programu tuto funkci 

zpřístupní. Plug-in je taktéţ volně ke staţení. 

Google SketchUp je také volně ke staţení. Bohuţel jeho free verze nabízená na webu 

Googlu nedokáţe ukládat modely do formátu collada. Tuto funkci dovoluje pouze verze 

s označením Pro, proto se o tomto softwaru zmiňuji ve variantě B. 

VARIANTA B – NÁKUP SOFTWARU 

Další variantou je nákup profesionálního 3D grafického softwaru. Placených programů 

podporující formát collada je hned několik. Následující tabulka obsahuje některé z nich 

včetně ceny za software. Osobně dávám přednost aplikaci 3DstudioMax, který povaţuji 

za vysoce profesionální grafický nástroj, čemuţ odpovídá i jeho cena. 

Tabulka 5: Placené grafické aplikace. 

Zdroj: vlastní.4 

Název programu Cena 

Autodesk 3D studio Max 3 495 USD 

Autodesk Maya 3 495 USD 

Google SketchUp Pro 7 354 € 

 

VARIANTA C – EXTERNÍ FIRMA 

Poslední mnou uváděnou moţností je externí firma. Zde je ale velmi obtíţné určit cenu 

takového modelu, protoţe ta se odvíjí z mnoha aspektů, počínaje náročností jak 

pracovní, tak technickou, mírou podkladů, detailů a objemu. 

                                                 
4
 Ceny programů firmy Autodesk [15] a Google [21] jsou z webových adres. 
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Nabízí se zde taky kupování modelů přes internet. Např. přes nově vzniklý webový 

server 3DVIA. Obsahuje i volně dostupné nebo placené modely. V současné době 

se na webové adrese nachází přes 200 985 modelů rozdělených do 233 skupin a toto 

číslo den ode dne roste.[11] 
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Závěr 

Bakalářská práce vyuţívá nových moderních trendů elektronického obchodu k návrhu 

katalogů. Cílem bylo vyuţití 3D technologií a přispět tak k rozvoji moderních trendů 

v oblasti elektronického obchodování.  

V teoretické části jsem se zabýval dvou a třídimenzionální grafikou, objasnil 

technologii collada. Analytická část je věnována analýze uţívání internetu a nákupu 

po internetu. Součástí je i SWOT analýza produktů v elektronických obchodech 

a zjištění strategií. 

Na základě těchto studií jsem přistoupil k samotné realizaci. Navrhl jsem 3D banner 

a 3D model pro elektronické obchody za pomocí nových technologií v oblasti 

actionscript 3 pro flash a pomocných rozšiřujících knihoven tzv. 3D engine podporující 

třídimenzionální pohled. Kromě toho tyto knihovny obsahují i základní fyzikální 

vlastnosti jako např. gravitace aj. 

Dále jsem zhodnotil návrh realizovaného řešení. Tato část obsahuje vyuţití obou 

realizovaných návrhů v komerční i nekomerční oblasti. I přesto, ţe jsem pouţil 

programy zdarma, zahrnul jsem do této části finanční zhodnocení několika placených 

aplikací, které lze pouţít k realizaci návrhu. 
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Seznam zkratek a pojmů 

Actionscript 3  objektově orientovaný programovací jazyk pro aplikace vyvíjené  

   pomocí Adobe Flash, případně dalších vývojářských nástrojů,  

   vyuţívajících stejného datového formátu. 

AI   formát programu Adobe Illustrator. 

AS3   zkratka pro actionscript 3. 

ATI    je jedním z výrobců grafických karet. Dále se zabývá výrobou v 

   oblasti videa a multimédií. 

Banner   Jedná se o zpravidla obdélníkový obrázek či animaci, případně  

   interaktivní grafiku zobrazenou nejčastěji poblíţ okraje   

   obrazovky. Bannery tvoří stále jednu z nejčastějších forem  

   reklamy na Internetu. 

Blog   webová aplikace obsahující příspěvky většinou jednoho editora  

   na jedné webové stránce. 

BMP   Microsoft Windows Bitmap. 

CDR   formát vektorové grafiky, který pouţívá jako svůj hlavní výstup  

   software Corel Draw. 

DirectX  v informatice sada knihoven poskytujících aplikační rozhraní  

   (API) pro umoţnění přímého ovládání moderního hardwaru.  

   Jejich cílem je maximální vyuţití moţností hardware jak po  

   stránce nabízených funkcí, tak z hlediska maximálního výkonu,  

   coţ je vyuţíváno pro tvorbu počítačových her, multimediálních  

   aplikací i grafického uţivatelského prostředí. 

DPI   (dots per inch) počet bodů na palec. 

DVI   Digital Visual Interface je rozhraní pro propojení videozařízení s  

   počítačem. 

EPS   Encapsulated PostScript. 

Font   kompletní sada znaků abecedy jedné velikosti a jednotného stylu. 

Freeware  volně šiřitelný program, který je zdarma. 

GIF   Graphics Interchange Format. 

GPU   (Graphic Processing Unit) grafický procesor. 
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H.264   Standard pro video kompresi. 

HD   (High-definition) s vysokým rozlišením. 

HDMI   zkratka anglického označení High-Definition Multi-media   

   Interface. Je to rozhraní pro přenos nekomprimovaného   

   obrazového a zvukového signálu v digitálním formátu. 

INDD   Adobe InDesign Document. 

Java   objektově orientovaný programovací jazyk, který vyvinula firma  

   Sun Microsystems. 

JPEG   Joint Photographic Experts Group. 

Kodek   zařízení nebo počítačový program, který dokáţe transformovat  

   datový proud (stream) nebo signál. 

Mpeg-4  kolekce patentovaných metod definujících kompresi a uloţení  

   zvukových a obrazových dat. 

Nvidia   (někdy téţ nVidia) je americká společnost specializující se na  

   výrobu grafických procesorů, osobních počítačů a handheldů. 

PDF   Portable Document Format. 

Plug-in  zásuvný modul, také plug-in je software, který nepracuje   

   samostatně, ale jako doplňkový modul jiné aplikace a rozšiřuje  

   tak její funkčnost. 

PNG   Portable Network Graphics. 

PostScript  programovací jazyk určený ke grafickému popisu tisknutelných  

   dokumentů. Jeho hlavní výhodou je, ţe je nezávislý na zařízení,  

   na kterém se má dokument tisknout. 

PSD   PhotoShop Document. 

QXD   QuarkXPress Document. 

Renderování  (rendering) tvorba reálného obrazu na základě počítačového  

   modelu, nejčastěji 3D. Rendering obsahuje v závislosti na   

   softwaru mnoho parametrů a nastavení, kterými lze ovlivnit  

   konečný vzhled scény. 

Subversion  systém pro správu a verzování zdrojových kódů. 

SVG   Scalable Vector Graphics. 

SWF   Small Web Format nebo Shockwave Flash. 
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TIFF   Tag Image File Format. 

URL   Uniform Resource Locator je internetová adresa webové stránky. 

Vray   renderovací program pro 3D grafické aplikace. 

XML   „eXtensible Markup Language“ rozšiřitelný značkovací   

   programovací jazyk. 
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3D banner 

Zdrojový kód pro TweenRotatingPlaneToYou.as: 

package { 

 

 import flash.display.Bitmap; 

 import flash.events.Event; 

 import flash.events.MouseEvent; 

 import flash.filters.BlurFilter; 

  

 import gs.TweenMax; 

 import gs.easing.*; 

  

 import org.papervision3d.core.math.Quaternion; 

 import org.papervision3d.events.InteractiveScene3DEvent; 

 import org.papervision3d.materials.BitmapMaterial; 

 import org.papervision3d.objects.DisplayObject3D; 

 import org.papervision3d.objects.primitives.Plane; 

 import org.papervision3d.view.BasicView; 

 import org.papervision3d.view.stats.StatsView; 

 

 [SWF(backgroundColor="#333333", frameRate="30", width="900", 

height="480")] 

   

 public class TweenRotatingPlanesToYou extends BasicView 

 { 

   

  [Embed(source="assets/foto1.jpg")] 

  private var asset1:Class; 



 

 

 

  [Embed(source="assets/foto2.jpg")] 

  private var asset2:Class; 

  [Embed(source="assets/foto3.jpg")] 

  private var asset3:Class; 

  [Embed(source="assets/foto4.jpg")] 

  private var asset4:Class; 

  [Embed(source="assets/foto5.jpg")] 

  private var asset5:Class; 

   

  [Embed(source="assets/pozadi3.jpg")] 

  private var background:Class; 

 

  private var planeAssets:Array = [asset1, asset2, asset3, asset4, asset5]; 

  private var planeContainer:DisplayObject3D = new DisplayObject3D(); 

  private var planeStaticContainer:DisplayObject3D = new 

DisplayObject3D(); 

  private var RotationReference:DisplayObject3D = new 

DisplayObject3D(); 

   

   

  private var previousPlane:CustomPlane; 

  private var startQuaternion:Quaternion = null; 

  private var endQuaternion:Quaternion = null; 

  private var currentQuaternion:Quaternion = null; 

 

  private static const NUM_PLANES:int = 40; 

  private static const TWEEN_TIME:Number = 1.5; 

 

  public function TweenRotatingPlanesToYou() 

  { 



 

 

 

   addChildAt(new background(), 0); 

   camera.focus = 100; 

   camera.zoom = 10; 

   camera.z = -1000; 

    

   viewport.interactive = true; 

   viewport.buttonMode  = true; 

 

   scene.addChild(planeContainer); 

   scene.addChild(planeStaticContainer); 

   scene.addChild(RotationReference); 

    

   setupPlanes(); 

   startRendering(); 

 

  } 

   

  private function setupPlanes():void 

  { 

   for(var i:int = 0; i < NUM_PLANES; i++) 

   { 

    var planeMaterial:BitmapMaterial = 

createRandomMaterial(); 

    planeMaterial.doubleSided = true; 

    planeMaterial.interactive = true; 

    planeMaterial.precise = true; 

 

    var plane:CustomPlane = new 

CustomPlane(planeMaterial, 900, 480); 

     



 

 

 

    plane.y = -500+(Math.random()*1000); 

 

    var radius:Number = Math.random()*3000+2500; 

    var offset:Number = Math.random()*(2*Math.PI); 

    plane.x = radius*Math.sin(offset); 

    plane.z = radius*Math.sin(offset+(Math.PI/2)); 

    plane.rotationY = -Math.atan2(plane.z, 

plane.x)*(180/Math.PI)+90; 

 

    planeContainer.addChild(plane);     

    singleRender(); 

     

    plane.slerp = 0; 

    plane.originalX = plane.x; 

    plane.originalY = plane.y; 

    plane.originalZ = plane.z; 

    plane.startQuaternion = 

Quaternion.createFromMatrix(plane.transform);  

 

   

 plane.addEventListener(InteractiveScene3DEvent.OBJECT_CLICK, 

plane_objectClickHandler); 

 

   } 

  } 

   

  private function createRandomMaterial():BitmapMaterial 

  { 

   var image:Bitmap = Bitmap(new 

planeAssets[Math.floor(Math.random() * planeAssets.length)]); 



 

 

 

   var planeMaterial:BitmapMaterial = new 

BitmapMaterial(image.bitmapData); 

    

   return planeMaterial; 

  } 

   

  private function 

plane_objectClickHandler(event:InteractiveScene3DEvent):void 

  { 

   tweenPreviousPlane(); 

  

   var plane:CustomPlane = CustomPlane(event.target); 

   if(previousPlane != plane) 

   { 

    tweenForward(plane); 

   } 

   if(plane.isAtStartingPoint) 

   { 

    previousPlane = null;  

   }else 

   { 

    previousPlane = plane; 

   } 

  } 

  

  private function tweenPreviousPlane():void 

  { 

   if(previousPlane && 

!previousPlane.isAtStartingPoint)tweenBack(previousPlane); 

  } 



 

 

 

   

  private function tweenForward(plane:CustomPlane):void 

  { 

   plane.isAtStartingPoint = false; 

    

   var tweenObject:Object = {}; 

   tweenObject.x = 0; 

   tweenObject.y = 0; 

   tweenObject.z = 0; 

   tweenObject.slerp = 1; 

  

   tweenObject.bezierThrough = [{x:-plane.x/4, y:-plane.y/4, z:300}]; 

   tweenObject.ease = Cubic.easeInOut; 

  

   tweenObject.onUpdate = plane_updateCallback; 

   tweenObject.onUpdateParams = [plane]; 

    

    tweenObject.onComplete = plane_switchContainer; 

   tweenObject.onCompleteParams = [plane]; 

  

   TweenMax.to(plane, TWEEN_TIME, tweenObject); 

  } 

  

  private function tweenBack(plane:CustomPlane):void 

  { 

   plane.isAtStartingPoint = true; 

    plane_switchContainer(plane); 

     

   var tweenObject:Object = {}; 

   tweenObject.x = plane.originalX; 



 

 

 

   tweenObject.y = plane.originalY; 

   tweenObject.z = plane.originalZ; 

   tweenObject.slerp = 0; 

  

   tweenObject.bezierThrough = [{x:-plane.x/4, y:-plane.y/4, z:700}]; 

   tweenObject.ease = Cubic.easeInOut; 

  

   tweenObject.onUpdate = plane_updateCallback; 

   tweenObject.onUpdateParams = [plane]; 

  

   TweenMax.to(plane, TWEEN_TIME, tweenObject); 

  } 

  

  private function plane_updateCallback(plane:CustomPlane):void 

  { 

   plane.endQuaternion = 

Quaternion.createFromMatrix(RotationReference.transform); 

   plane.currentQuaternion = 

Quaternion.slerp(plane.startQuaternion, plane.endQuaternion, plane.slerp); 

   plane.transform.copy3x3(plane.currentQuaternion.matrix); 

  } 

 

  private function plane_switchContainer(plane:CustomPlane):void 

  { 

   plane.parent.removeChild(plane); 

   if (plane.isAtStartingPoint) { 

    plane_updateCallback(plane); 

    planeContainer.addChild(plane); 

   } else { 

    plane.rotationY = 0; 



 

 

 

    planeStaticContainer.addChild(plane); 

   } 

  } 

 

  override protected function onRenderTick(event:Event = null):void 

  { 

   planeContainer.yaw(0.1); 

   RotationReference.yaw(-0.1); 

   super.onRenderTick(event); 

  } 

 } 

} 

Zdrojový kód pro CustomPlane.as: 

package 

{ 

 import org.papervision3d.core.proto.MaterialObject3D; 

 import org.papervision3d.objects.primitives.Plane; 

 import org.papervision3d.core.math.Quaternion; 

  

 public class CustomPlane extends Plane 

 { 

  public var slerp:Number = 0; 

  public var startQuaternion:Quaternion = new Quaternion(); 

  public var endQuaternion:Quaternion = new Quaternion(); 

  public var currentQuaternion:Quaternion = new Quaternion(); 

  public var originalX:Number = 0; 

  public var originalY:Number = 0; 

  public var originalZ:Number = 0; 

  public var isAtStartingPoint:Boolean = true; 



 

 

 

   

  public function CustomPlane(material:MaterialObject3D=null, 

width:Number=0, height:Number=0, segmentsW:Number=0, segmentsH:Number=0) 

  { 

   super(material, width, height, segmentsW, segmentsH); 

  } 

   

 } 

} 

  



 

 

 

Příloha č. 6  

3D model 

Zdrojový kód pro Main.as: 

package   

{ 

 import flash.events.Event; 

 import org.papervision3d.materials.BitmapFileMaterial; 

 import org.papervision3d.materials.utils.MaterialsList; 

 import org.papervision3d.objects.DisplayObject3D; 

 import org.papervision3d.objects.parsers.Collada; 

 import org.papervision3d.view.BasicView; 

 

 public class Main extends BasicView  

 { 

  protected var cow:DisplayObject3D; 

  protected var materialList:MaterialsList; 

  protected var bitmapFileMaterial:BitmapFileMaterial; 

   

  protected var sceneWidth:Number; 

  protected var sceneHeight:Number; 

   

  public function Main()  

  { 

   super(); 

   init(); 

   createChildren(); 

   startRendering(); 

  } 

  protected function init():void  



 

 

 

  { 

   sceneWidth = stage.stageWidth 

  } 

  public function createChildren():void  

  { 

   materialList   = new MaterialsList(); 

   bitmapFileMaterial  = new 

BitmapFileMaterial("daeModel/Cow.png"); 

   materialList.addMaterial(bitmapFileMaterial,"all"); 

    

   cow = new Collada("daeModel/cow.dae",materialList); 

 

   cow.moveDown(350); 

   cow.scale = 4; 

   cow.pitch( -10); 

 

   scene.addChild(cow); 

  } 

  override protected function onRenderTick(event:Event = null):void  

  { 

   super.onRenderTick(event); 

   cow.rotationY = stage.mouseX / sceneWidth * 360 

   //cow.rotationX = stage.mouseY / sceneWidth * 360 

  } 

 } 

} 

  



 

 

 

Příloha č. 7  

Ukázka renderování pomocí Vray v 3ds max 

 



 

 

 

Příloha č. 8  

Ukázka 3D banneru pro blog 

  



 

 

 

;Příloha č. 9  

Ukázka 3D modelů v e-shop katalogu 

 


